
Reading Tools Training Manual I

High Tech Center Training Unit
Of the California Community Colleges at the
Foothill-De Anza Community College District

21050 McClellan Road
Cupertino, CA 95014

(408) 996-4636

Rev. 1/13/98





Table of Contents

BookWise Edge ver 3 (Win 95) ............................................................. 1
Carmen Sandiego Word Detective (Win/Mac CD-ROM) ..........................3
Omni 3000 1.1.1 (Win) ....................................................................... 5
OMTI-Rogers (Win CD-ROM) ............................................................ 7
outSPOKEN (Mac) ............................................................................. 9
Phoneme Sequencing for Reading and Spelling: (Mac/Win CD ROM) .... 11
The Reading Edge ............................................................................ 13
SkillsBank 4 (Win) ) .......................................................................... 15
Speed Reader (Win) .......................................................................... 17
Spell It 3 (Win) ................................................................................. 19
TextAssist (Win 3.x/95) ..................................................................... 21
textHelp! Ver 2.10 (Win) ................................................................... 23
Ultimate Word Attack (Win/Mac CD) ) .............................................. 27
Word Munchers Deluxe (Win 3.x, 95/Mac CD) ..................................... 31
ZoomText Xtra (Win) ......................................................................... 35
Addendum........................................................................................ 41





BookWise Edge ver 3 (Win 95)

Publisher: Retail Cost: $ 5995.00

Xerox Imaging Systems
9 Centennial Drive
Peabody, MA 01960
(800) 248-6550 or (508) 977-2000
www.xerox.com

System Requirements:
BookWise 3 will run on any IBM PC 386 or greater with 8 MB RAM and 20
MB of free disk space. BookWise 3.0 is supported on both Windows
platforms. A scanner and sound card are necessary if the Reading Edge is
not used with BookWise. See the "Notes" section at the end of this guide.

Description:
BookWise Edge is BookWise software running on a PC attached to the
Reading Edge scanner which also serves as the synthesizer source.
BookWise software alone can be installed on a PC which is attached to a
regular scanner and a compatible sound card used as the speech synthesizer
source. BookWise is a PC-based interactive system which scans books and
other printed materials, converts the text to synthesized speech, highlights
the text, and reads it aloud. Bookwise recognizes almost any printed text,
including faxed, typewritten, laser-printed and photo-copied materials, and
the program recognizes almost every type style from size 8 to 72 points.

BookWise is able to:

• Read at a syllabic, word, phrase or sentence level
• Read at different speeds
• Adjust speech loudness
• Edit scanned text

Recommended Uses:
BookWise is recommended for students who will benefit from a multisensory
approach to reading: hearing and seeing.

Basic Use:
1. Turn on Reading Edge and place material to be scanned in scanner.
2. Tap the Select Input key of reading keypad until "Receive ScreenReader

input" is heard.
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3. Turn on computer; select BookWise from the menu
4. Click the Scan icon to start scanning.
5. Give file a name and save the text file; text will appear on-screen.
6. Begin automatic reading by clicking the Green Arrow icon.
7. It is possible to edit this scanned text.
8. Explore the menu options for other available settings (e.g., colors, font

and size of text, etc.)

Notes:
Pricing:

BookWise System 1
(Includes BookEdge Scanner; BookWise 3.0;
read/scan software, and PC DECtalk
synthesizer with speakers.)

BookWise 3.0 Read/Scan station software
with PC DECtalk speech

BookWise 3.0 Read/Scan station software

BookWise 3.0 Read station software
with PC DECtalk synthesizer

4,790.00

2,095.00

895.00

1,695.00

BookWise Read station software 495.00
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Carmen Sandiego Word Detective (Win/Mac CD-
ROM) 

Publisher: Retail Cost: $ 38.95
Broderbund
500 Redwood Blvd.
Novato, CA 94948-6121
(415)-382-4747 tech support
http://www.broderbund.com
http://www.carmensandiego.com

System Requirements:
For Windows 3.x and 95: 486DX, 66MHz or faster; 8MB RAM for Windows
.3.x; 16 MB for Windows 95; minimum of 20 MB hard disk space; 2x CD-
ROM; 640x480 SVGA display at 256 colors; High and True colors supported;
sound card; video and sound card must be compatible with DirectX for Win
95.
For Macintosh and PowerPC: System 7.1 or higher, 20MHz 68040 processor
or faster; PowerPC, free RAM: 6 MB for 68080 Macintosh and 7 MB for the
PowerPC, a minimum of 20MB hard disk space, double-speed CD-ROM drive;
640x480 display at 256 colors.

Description:
This program successfully incorporates numerous spelling, vocabulary, and
word-reading activities into a rich, engaging multimedia environment. The
richness of the multimedia enhances the learning tasks, and the "adventure"
element does not overwhelm or diminish the learning activities. If continued
to the end, there are more than 60 spelling, grammar and vocabulary
activities to be completed in the context of 12 dangerous missions. Successful
completion of a mission results in freedom for one of the 12 "good guys" held
in the Babble-On machine by Carmen Sandiego and her V.I.L.E. henchmen.
When in the clutches of this machine, a person loses the ability to speak
normally and only can babble.

There is a practice mode, known as the Training Simulator (found under
the Options button on the main screen) which features a large number of
exercises that develop spelling, grammar and vocabulary proficiency, along
with 18 fact-filled articles and stories that shed light on science, history,
geography, and even the elusive Carmen Sandiego. This option allows a user
to practice activities without being in a game mode.

Reading Tools Page 3



Recommended Uses:
This program should please multiple types of learners wanting a fresh
environment in which to practice basic spelling, grammar, and vocabulary
exercises.

Basic Use:
1. Open the program by double clicking on the program icon in the training

folder. A multimedia segment plays and provides introductory
information about the adventure. A log-in screen appears.

2. Enter name and click the Log-In button. The main screen appears.
3. Click on the Options button, then the Training Simulator button to

open a menu of activity options. Explore each one to become familiar with
the activities which occur during the game. There are three levels of
difficulty to choose from.

4. To begin the game, select the level at which to play (one, two or three) by
clicking on the desired Level button, then click on the Transport button
and then the Launch button to go to the depicted site.

5. When in a location, pass the mouse over the scene to pan around the
environment. Hot spots are revealed by a highlight. Click on a highlight
and a word activity appears. Successful completion of the activity yields
information about a password. More than one activity is contained on a
screen. Adequate voice prompts guide the user.

6. Successfully completing the adventure frees one of the ACME agents held
in the Babble-On machine.

The Word Machines 
• Code Breaker: Find or create words from the jumbled letters displayed;

similar to a word seek task.
• Fusion Chamber: Expand vocabulary by choosing prefixes or suffixes to

create new words; then match these words to the correct definition. The
program uses color excellently to reinforce concepts of word prefix, root,
and suffix.

• Micropix: Choose correct parts of speech to complete a variety of text
passages. Word choices offer definitions, if desired by user.

• Power Pack: Use strategic thinking in this challenging alphabetizing
activity. This task requires visual planning skills.

• Spellanyzer: A multi-sensory tool (auditory and visual, kinesthetic) to
provide spelling practice.

Notes:
Move the mouse pointer to the top of the screen and click the left mouse
button to bring up the Carmen Sandiego Word Detective menu bar. General
sound control and word presentation mode for the Spellanyzer can be found
here.
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Omni 3000 1.1.1 (Win)

Publisher: Retail Cost: $ 1995.00

Kurzweil Educational Systems, Inc.
411 Waverley Oaks Road
Waltham, MA 02154
800-894-5374
http://www.krurzweiledu.com

System Requirements:
• Pentium 75 MHz processor
• 16 MB of RAM required, 32MB recommended
• 1 GB hard disk drive
• 1.44 MB 3.5" floppy disk drive
• CD-ROM drive
• SVGA monitor
• Single-pass color flat-bed scanner, preferably a Hewlett-Packard ScanJet

3p or above
• 16-bit or better sound card
• Microphone, if you wish to use the voice command option
• Full size keyboard with mouse
• Windows 95

Description:
The Omni 3000 is a computer-based reading system that converts printed
material into speech. Users can hear printed words spoken aloud as they
read them on the computer screen. In addition to reading documents, users
can use dictionary and phonetic spelling tools to enhance their reading.
Scanned pages appear on the screen as they appear in the original material.
As the Omni 3000 reads, it highlights each word and its context. The
reading voice, background/foreground colors, and text size are easily
adjustable.

Recommended Uses:
The Omni 3000 was designed for sighted users who have difficulty reading.
It could be used in any setting where students need access to print materials.
It may also serve as a writing environment for users who would benefit from
its special features. Because there are many on-screen controls available, it
is not as suitable as a reading machine for non-sighted students as the
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companion product the Omni 1000 which provides easy access for non-
sighted users.

Basic Use:
1. Start the Omni 3000. Enter your name if prompted. A window appears

with a number of menus, buttons, and combo boxes.
2. Run the mouse pointer over the buttons, pausing over each without

clicking and read the tool tips that appear which describe each button's
function.

3. To scan a document, place it in the scanner and click the Scan button.
4. After the image of the document appears on the screen, resize it to your

desired size by choosing a percentage in the Zoom box or by clicking on
the little arrows on the box.

5. Read the document by clicking on the Play button. Notice the Play
button changes to a Pause button to be clicked when you wish to stop
reading.

6. To get more information on a word, highlight any word in the document
by double-clicking on it. Click on the Dictionary button in the toolbar.

7. Click the Read button to hear the definitions read aloud. To see a list of
words with similar meanings, click Get Synonyms.

Intermediate Use:
1. Click the right mouse button in the document to see a context menu of

choices to make. This method may prove to be quicker.
2. To select a reading unit, choose from the Read By list box either by word,

by phrase, by sentence, by line, or by paragraph.
3. To select a reading mode, choose from the Read Mode list box.

Continuous mode will read until you stop it with a mouse click or clicking
on the pause button. If you choose Self-Paced, reading will pause at the
end of whatever reading you have selected.

Notes:
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OMTI-Rogers (Win CD-ROM)

Publisher: Retail Cost: $ 175.00
OMTI-Rogers
75 Federal Street, Suite 102
San Francisco, CA 94107
(415) 547-1649

System Requirements:
A 486 or higher processor with 8 MB of RAM, Windows 3.1 or higher, Super
VGA (640 x 480, 256 color) monitor, at least a double-speech CD-ROM drive,
Windows-compatible sound card, speaker.

Description:
This is a multimedia disk designed for facilitated self-study which introduces
basic reading skills using Orton-Gillingham methods. True to a multi-
sensory approach, it is expected that the student will write for some activities
in addition to working on the computer keyboard. Developed by a long-time
professional special educator, the program is new, and has been well-received
by those who use Orton-Gillingham activities with their students. A student's
records and progress are kept and monitored by the program. A good verbal
introduction is provided for the student. The graphics are adult in nature
and extremely appropriate.

The following basic lessons are included:
Letter Lessons
Reading Lessons
Writing Lessons
Spelling Lessons
Language Rules
Dictionary Skills

Recommended Uses:
The program is recommended for students wishing a foundation course in
phonics and basic reading.

Basic Use:
After following the steps to select a personal icon, do the following.
1. Click on the down arrow on the right at the bottom of the screen. This

takes the user to the content and lesson menu.
2. Click on the square buttons to hear the content area each represents.
3. To go to a lesson, click on one of the blue lights depicted on the screen.
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Notes:
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outSPOKEN (Mac)

Publisher: RetailCost: $495.00
ALVA Access Group, Inc.
5801 Christie Avenue #475
Emeryville, CA 94608
(510) 883-6280
aagi.com

System Requirements:
Macintosh

Description:
At this time, outSPOKEN is the only screen reader for the Macintosh
computer. It reads the Macintosh screen display and provides a keyboard
alternative to the mouse. Several embossed sheets aid the blind user in
understanding the Macintosh screen layout. Instructions also come in
Braille.

Recommended Uses:
Used as a screen reader for persons who are blind, it also is useful for
students with learning disabilities who benefit from auditory text editing.

Basic Use:
1. outSPOKEN is installed in the system folder. Press Command and the

Clear key on the numeric keypad to turn outSPOKEN on or off.
2. Open a file to be read with a word processor.
3. Using the mouse, place the I-Bar at the beginning of the word or line to be

read. Use the following key commands from the numeric keypad.

Basic Commands:
To read a line (I-Bar moves to next)
To read a line (I-Bar does not move)
To read word at I-Bar, move right

Other Commands:
To move I-Bar to top of document screen
To read word, move left
To read one letter, move right
To read one letter, move left

Two (2) key
Enter key
Six (6) key

Seven (7) key
Four (4) key
Shift Six (6) key
Shift Four (4) key
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4. It also is possible to read a word by using the mouse to move the I-bar
over the word.

Notes:
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Phoneme Sequencing for Reading and Spelling:
The Lindamood Program (Mac/Win CD ROM) 

Publisher:
Gander Publishing
416 Higuera Street
San Louis Obispo, CA 93401
(800) 554-3836

Retail Cost: $ 295 for single user

System Requirements:
A 486 machine running Windows 3.x or 95;CD ROM drive, (quad-speed is
strongly recommended); Sound Blaster Pro (or 100% Sound Blaster
compatible); VGA monitor capable of 640 x 480pixel display at 256 colors;
8 MB of physical RAM (16 megabytes is strongly recommended).

Description:
The overall goal of this program is the direct development of phonemic
awareness--the ability to think about and manipulate the identity, number,
and order of individual sounds within words-- and application of phonemic
awareness for independence and self-correction in spelling and reading

Recommended Uses:
The modules on this CD provide problem-solving activities to reinforce the
concepts presented in the Lindamood Phoneme Sequencing Program: that
consonants and vowels can be felt, first just as single sounds then as
sequences of sounds within words. Before students go to the computer, it is
extremely important for an instructor to use the questioning process
illustrated in the sample dialogues in the Lindamood Program manual
and/or the Training Video Tapes to help students discover they can feel
consonant and vowel sounds. This interactive questioning elicits this
sensory-cognitive thinking and reasoning base, the computer problem-solving
activities can further reinforce this base.

There are five processing steps to be mastered:
• consonants
• vowels
• tracking
• spelling
• reading
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With this program, students are helped to integrate oral-motor feedback with
visual and auditory feedback to track and verify the identity, number, and
order of sounds within spoken words.

Basic Use:
1. Start the program from the Program menu.
2. Enter first and last name in user box so progress can be tracked.
3. Select type of sounds to be practiced.
4. Follow instructions.

Notes:
The activities on this disk represent a milestone in technology for phoneme
awareness and practice activities.

Page 12 Reading Tools



The Reading Edge

Publisher: Retail Cost: $5,495.00
Xerox Imaging Systems
9 Centennial Drive
Peabody, MA 01960
(800) 248-6550 or (508) 977-2000
www.xerox.com

System Requirements:
N/A

Description:
The Reading Edge is the most current version of the reading machines in the
Kurzweil Personal Reader series. It is an entirely self-contained version of
the KPR Model 7315. Reading Edge is intended for persons who are blind,
have low-vision or visual processing deficits. The Reading Edge scans most
textbooks and other printed materials then reads aloud what it has "seen."
The system is accurate, reasonably fast, and easy to use. This is a
"dedicated" reading machine which includes both scanning and reading
capability.

• Stores 50 to 100 pages of scanned text in memory.

• Reading speed is adjustable from 40 to 550 wpm.

• Reads letters, words, lines, sentences, paragraphs, pages or entire
documents.

• Output can be directed to a tape recorder or text file on Macintosh, MS-
DOS or UNIX computers.

• Uses high quality DECtalk speech synthesis.

• Full auditory help functions available for all functions at all times.

• Documentation available in print, audio tape, or Braille format.

• Does not read hand written or printed material and works best with clean,
original, black and white copy. Letters which touch or copy which is faded
or blurred will create problems.
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• Can read print from 8 to 77 points in height.

Recommended Uses:
This is a useful tool for persons who are blind, have low vision or learning
disabilities. May also be useful for ESL and older adult populations.

Basic Use:
1. Turn on the Reading Edge using the rocker switch located underneath the

side of the front left corner of the unit.

2. Open the scanner cover and place the document to be scanned face down
on the glass scanner surface. Close the scanner cover.

3. Press the key at the bottom left corner of the keypad labeled Start/Stop
Scanning.

4. When the scanner announces "Scanner ready for next page," open the
scanner cover and remove document.

5. To start/stop reading, press the large yellow key labeled Stop/Continue
Reading or Shift.

6. Volume and reading speed are adjusted using the two control knobs on
the right side of the reader. The one which doesn't click is the volume
control.

7. To learn more about the operation of all keys on the keypad, first tap and
release the key at the bottom right corner of the keypad labeled
Help/Status; next, press and hold down the key you wish to learn about.
A complete description of the key's function(s) will be read to you.

Notes:
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SkillsBank 4 (Win )

Publisher:
Skills Bank Corporation
Park View Center 1
7104 Ambassador Road
Baltimore, MD 21244
(800) 451-5726
www.skillsbank.com

Retail Cost: $1,245.00

System Requirements:
Skills Bank 4 will work in Windows 3.1, Windows 95, NT; purchasable as a
single-user CD, 5-user lab pack, or as a network version (50-user or
unlimited in one building).

Description:
Skills Bank 4 is an all-new version of the basic SkillsBank 3 program. The
activities are the same, but the format is different. The program now comes
on CD ROM only. Critical thinking strands are incorporated throughout
each subject area. The 200 plus topics are contained in 19 subject areas. The
program comes contains these basic content areas: reading, language,
writing, basic mathematics, intermediate mathematics, and information
skills.

Recommended Uses:
Skills Bank software is useful for any student needing a brief, basic tutorial
review in major basic skills areas. This new version comes with a
complement of in-depth activities which can be purchased. There are two
Practice series and a MathCheck starter kit currently available.

Major Components:
Diagnostic and prescriptive pre-tests
Basic skills lessons
Quizzes
Thinking skill lessons

New Features
• Voice and sound guide students through lessons and provide an extra

modality for learning
• Lessons on Internet fundamentals are included.
• Mathematics activities have been revised and there are 40 new activities.
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• Purchasable Language Practice Series provides 22 add-on lessons with
open-ended interactive practice on all concepts in SkillsBank Language
Series.

• Purchasable Computation Practice Series features 24 add-on lessons with
randomly generated problems in an open-ended interactive setting.

• Enhanced teacher reports
• Purchasable mathematics worksheet generator (MathCheck) which offers

add-on libraries of additional math content.

Notes:
Pricing:
Single User Set (Basic Skills)
5-User Lab Pack
50-User Net Site
Unlimited Net Site

$1245.00
$2490.00
$4980.00
$7470.00
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Speed Reader (Win)

Publisher: Retail Cost: $39.95
Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677
www.davd.com

System Requirements:
80286 processor or higher with at least 1Mb of memory, hard drive, VGA,
EGA, or Hercules card, Windows 3.0 or higher, mouse recommended

Description:
Speed Reader for Windows is designed to help improve reading speed,
comprehension and retention rate. It will assess students' current reading
speed and comprehension level and prescribe an individualized training
program for them.

Speed Reader contains nine different topics of reading passages and allows
users to import text using either a text file or the Windows clipboard. The
learning activities include: warm-up exercises with letters and words, eye
movement lessons, column or newspaper reading, paced reading, timed
reading, and Eye Max, a game for improving peripheral vision. Speed
Reader has a record keeping feature that will provide reports and graphs of
progress. It also provides timing and pacing for off-screen reading practice.

Recommended Uses:
Speed Reader can be used as a self-study course to improve reading speed
and comprehension. The manual provides detailed practice sessions to guide
the student through the self-study course.

Basic Use:
1. Begin Speed Reader by double clicking on the Speed Reader icon. The

Student Registration box will appear. You may register as a New
Student, a Continuing Student, or as a Visitor.

2. Register as a New Student and take an assessment test to establish your
base reading speed and comprehension level, and to set your target
reading speed. Speed Reader will create a Training Program to suit your
needs and will save your reading speed and comprehension scores.

3. To display your Training Program, click the Training Program button.
To return to the Main screen, click the Main Screen button.
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4. Choose one of the activities from the Main Screen by clicking on one of the
large buttons labeled Reading Warm-ups, Eye Movement,
Newspaper Reading, Paced Reading, Timed Reading, or Eye Max.

Notes:
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Spell It 3 (Win)

Publisher: Retail Cost: $ 49.00
Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677
www.davd.com

System Requirements:
A 386/25 MHz or faster DOS-based machine running Windows 3.1; a hard
disk with at least 5 MB free space; Windows-supported sound card
recommended; 4 MB of RAM

Description:
This program is designed to incorporate fun into the mastery of new spelling
words. It is designed to help students of all ages develop and improve
spelling skills. As students move through the program, they read spelling
words in context sentences, see words broken into syllables, distinguish
between correct and incorrect spellings, and complete, unscramble, and edit
these words.

Recommended Uses:
This program is useful for a broad range of students, because in addition to
the 3600 word from first grade level to adult, there is an authoring
component which allows an instructor or student customize spelling lists.

Basic Use:
1. Start Windows; double click on the Spell It 3 icon.
2. Register as New Student, Continuing Student or Visitor.
3. Select desired vocabulary level and a category.
4. Explore the major activities:

• Bayou Word Preview
See Word
Finish Word
Flash Word

• Leap to Complete
(fill-in missing letters game)

• Frog Crossing
(crossword puzzle game)

• Midnight Correction
(editing, proofing activity)

• Bullfrog Log Game
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(an arcade game based on correct word recognition)

Notes:
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TextAssist (Win 3.x/95)

Publisher: Retail Cost: $ Included w/ Card
Creative Labs, Inc.
1901 McCarthy Boulevard
Milpitas, CA 95035

System Requirements:
A Sound Blaster card that supports TextAssist, 386SX-25 w/ 4MB RAM, 2
MB hard disk space, Windows 3.x or Windows 95.

Description:
The TextAssist TextReader provides high quality speech output for selected
text. Options to change the volume, rate, and pitch of the current
TextReader voices are accessible via the TextReader button bar or the
System menu. The speech is customizable to the voices of the familiar
DECtalk speech synthesizers.

Recommended Uses:
The TextReader application can serve as a proofreader for any user, but is
especially useful for those who have difficulty reading.

Basic Use:

1. To launch the Text Assist TextReader, double click on the icon( Win 3.x);
in Windows 95, select Programs, SoundBlaster, and then Text
Reader. A button bar appears on the screen. This bar controls the flow
of speech similar to a tape player controls. The right arrow is the
play/stop button and the button to its right is the pause/resume button.
Clicking the larger rectangle against the right end of the button bar
activates the volume and rate slider bar, clicking on the small rectangle
against the right end of the button bar closes the Text Reader application.

2. Start an application or file containing text to be read.
3. Highlight the portion of the text to be read by selecting the it with the

mouse.
4. Click on the Play button of the button bar to hear the text spoken. If no

text is highlighted, clicking the start button will cause TextReader to read
the entire document.

Notes:
In Windows 3.x it is possible to have a text file read in File Manager by
dragging the file icon up to the TextReader button bar.
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In Windows 95, it is possible to do the same from Windows Explorer.
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textHelp! Ver 2.10 (Win)

Publisher: Retail Cost: $ 250.00

Lorien Systems
Enkalon Business Part
25 Randalstown Road
Antrim
Co. Antrim
Northern Ireland
BT41 4LJ
(44) 0 1849 428574 (Fax)
U.S. contact (800) 747-0429
sales@loriens.com
support@loriens.com

System Requirements:
Windows 3.1x, at least at 386DX processor running at 33 MHz; 4 MB RAM,
although 8 is recommended; up to 16 MB free disk space before installation;
a Sound Blaster compatible sound card.

Description:
This software program provides students with learning disabilities and
dyslexia with specialized tools to make the writing and reading process
easier. textHelp! is a free-standing utility which works with other
applications. The program speaks text as it be being typed, performs real
time spell checking, can suggest phonetically close spellings, will
automatically correct words, will support a small magnified viewing area,
and provides automatic word prediction as a person types. Although in
actual practice any one student generally will only use a few of these
features, they all will work together.

Lorien Systems also sells an institutional site license (e.g., $9,000 for 15,000
users) and all users (staff and students) are free to copy the program

Recommended Uses:
This program is recommended for students who have difficulty spelling,
difficulty in reading what they have written, or who have poor recognition
ability in differentiating between homonyms. Additionally some students
with mild visual disability may benefit from the limited ability of the
program to magnify small areas of text, and students with orthopedic
difficulties who are unable to key in text rapidly may benefit from using this
program.
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Basic Use:
Starting the Program
1. From the Program Manager Icon, double -click on the textHelp! icon.
The program (in default usage) puts up a blank word suggestion box.

2. Start a word processing program: e.g., Word for Windows or Write.

3. Depending upon its settings, textHELP! will appear as a small window on
top of the document screen or as a small toolbar positioned in the title bar of
the major application.

4. The following basic functions can be accessed by hot keys:

Display the Main Menu
It is possible to display the main menu by pressing Alt-Ctrl-M. When the
tool bar is displayed, it is also possible to click on the Menu button (the last
button on the right) to bring up the main menu.

Toggle Word Prediction
Pressing Alt-Ctrl-P starts or stops the word prediction function. When the
function is invoked, the toolbar moves to the word prediction panel which is
positioned on top of the document window.

Using the word prediction function is very easy: watch the panel as keys are
entered, enter the number of the word when it appears in the word prediction
panel. Press the Spacebar after the word has been entered. The word will be
spoken if the speech option has been set up to include word echo.

Toggle Real Time Spell Check
The command Alt-Ctrl-S starts and stops the ability of textHelp! to monitor
keystrokes as they are entered. If the program detects a word not it its
dictionary, or a misspelled word, a spell check window appears on the screen

In order to bring up suggested word list, enter Alt-G or click on the Suggest
button. Move the highlight through the words, pressing Alt-S or clicking or
the Speak button to have the word pronounced. Tapping Enter when the
highlight bar is on the desired word replaces the misspelled word with the
correctly spelled word. The command Alt-R will do the same thing.

Speak Selected Text
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Entering Alt-Ctrl-V causes textHelp! to read any text which has been
selected. The only way to stop the speech is to select Stop Speech from the
main menu (Alt-Ctrl-M).

Toggle the Magnification Function (the Zoomer)
The command Alt-Ctrl-Z turns on and off the textHelp! magnification
function. It also is possible to control the magnification function from the
main menu.

Temporarily Stop All Text Help Functions
The hotkey combination Alt-Ctrl-X stops textHelp! from processing any
keystrokes (However, it will not stop speech already in progress; only the
Stop Speech selection from the main menu will do that)

Notes:
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Ultimate Word Attack (Win/Mac CD) )

Publisher: Retail Cost: $ 29.95

Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677

System Requirements:
Multimedia PC with 5 MB free space; Windows 3.1 or 95; 8 MB RAM.
Macintosh: LC III or Power PC with 5 MB free space; System 7.1 or higher.

Description:
Ultimate Word Attack is a versatile, economical program for spelling drill.
This version has 2 CDs and is a hybrid set, meaning that for the same price,
you get CDs that will run on a Mac or PC. The activities are the same as
those in Word Attack 3, but the presentation and graphics have changed.
The vocabulary lists are extensive, and well organized by and within
category.

In addition to a presentation activity, there are four activities:
• a tile game where definitions must match an exposed tile
• a crossword puzzle game which uses fill-in the sentence blank or

definitions as clues
• a maze game with an arcade-type format
• a hat game with an arcade-type format

Record keeping activities and an easy-to-use authoring component are
included.

Recommended Uses:
Recommended for students who wish to work on vocabulary development.
Both reading and spelling activities are included in response formats.

Basic Use:

The Main Menu
There are four basic menus:

• the File menu which accesses student records or authoring activities;
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• the Word List menu which controls word list level and the ability to
view an entire word list;

• the Activity menu which controls such basic functions as speech,
sound, starting and stopping, options;

• the Help menu which provides access to on-screen instructions or on-
screen hints.

Program Activities:

Presentation Activity
Begin with this activity in order to familiarize the student with the
vocabulary list. If a speech device is included, each word will be spoken as it
is introduced visually. There are three levels of difficulty to work in: Study,
a passive, activity; Solve, an activity requiring the user to enter target word
from the keyboard (target word is displayed); or Complete the Sentence
(user must type in the word from memory).

Tile Activity
The user is challenged to clear the tiles off the screen by matching each word
with its definition. The definitions for the words are displayed below the
tiles. If one of the words on screen does not match the definition, use the
arrows to scroll through the definitions until you are able to make a correct
match. A match clears a tile from the screen and uncovers the tile beneath it.
Clear all the tiles to win. Double click on a tile to select it.

Crossword Puzzle
In this activity, match each word with its clue. If the highlighted letter box is
shared by two words, two clues will appear: one for the across word and one
for the down word. To move from word to word, use Tab, arrow keys or click
the letter box with the mouse. There three modes of play: clues can be
Definitions, Sentences or Mixed--a combination of clues in definition or
sentence form

Maze Game
Move the Mascot Character (M.C.) through the vertical maze before time
runs out. This character is to be moved through the maze so that he can eat
the word which has its definition displayed at the bottom of the screen. The
player needs to figure which word is accessible and then must select its
definition (by rotating through the definition list) before the character can be
moved to gobble the target word

Slime Game
This is an arcade-type activity. The object is to help the M.C. throw balls at
the word that matches each definition that appears at the bottom of the
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screen. To play, look at the definition at the bottom of the screen; click at the
correct word or use the up or down arrow to move the M.C. directly across
from the word and then press Spacebar. If the word is correct, a slime
creature falls from the pipe. The pace of the game is controlled by choosing
Easy, Medium, or Hard level of difficulty at the beginning of the game.

Editor
The Editor, an easy-to-use authoring tool, allows the user to make new word
lists. It is possible to select words already included in the program or to
input new words. It is necessary to provide a definition and two sentences in
which the word is used. Give the file a name when it is saved. To use this
word list, select custom from the Word List menu, and select from the file
names displayed.

Stopping
Go to the Activity Menu at the top of the screen and select Stop. Selecting
Quit from the File Menu will exit the program.

An Add-On
There is a companion audio CD with 25 vocabulary lists of 11 words each.
Each word is spoken, a definition is given and then the word is used in a
sentence. Voices alternate from female to male. The words are not a part of
the software game, but are listed in the documentation folder. The auditory
information could be transcribed into the editor if one wished to use words
from the audio CD. This disc could also be used for vocabulary enhancement
while commuting.

Notes:
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Word Munchers Deluxe (Win 3.x, 95/Mac CD)

Publisher: Retail Cost: $ 14.95

MECC
6160 Summit Drive North
Minneapolis, MN 55430-4003
612-569-1500
http://www.mecc.com/

System Requirements:
This disc supports the Macintosh, and Windows 3.x and 95.
• Specific requirements for the Windows 3.x version: 486/50MHz or higher,

256 SVGA color display, 4 MB RAM, although 8 recommended, double-
speed CD-ROM, mouse, and sound card.

• Specific requirements for the Windows 95 version: 486/50 MHz or higher,
256 color SVGA display, double-speed CD-ROM, 8 MB RAM, mouse,
sound card.

• Specific requirements for the Macintosh: 68040 or higher (Performs 575
or greater), System 7.1 or later, 5 MB RAM (8 recommended), double-
speed CD-ROM.

Description:
This program is an expanded version of the original Word Munchers grid
game which required students to select words containing a target vowel
sound. This model has been increased to include word selection activities
related to linguistic elements and tasks. The program is designed for use
with a range of ages, and allows the user to choose whether or not to play
with "Troggles" (cartoon creatures which chase the player if play is moving
too slowly).

The game materials are organized by grade level: grades one through five.
The use of "grade level" as the reference for game structure is unfortunate,
for the stimulus materials are presented in a relative grade-free manner. For
older learners, the term "level one," rather than "grade one" would have been
more appropriate.

It is possible to control sound and music options from the menu bar. The
only way to stop a game is from the File option on the menu bar.

Recommended Uses:
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This program may be useful in facilitating automaticity in the
decoding/encoding processes of reading and writing. The small cost of this
disc, coupled with its range of linguistic activities structured in the long-
popular Word Munchers format, make it a useful addition to a software
library. Some activities requiring students to match sounds to objects
pictured may be difficult for some persons with visual perceptual difficulties

Basic Use:
1. Double-click on the Word Munchers icon.
2. Select Play Troggle-Free and the program will open to the main

menu.
3. Select the level of play desired by clicking on the appropriate tab.
4. Select the game content and subject matter by clicking one the topics

listed on the left page of the main menu graphic; select or de-select the
desired stimulus materials from the right page by clicking the check
boxes.

5. Decide whether to have stimulus material topics presented in the
order listed or in random fashion by clicking the In Order/Random
toggle button at bottom of the right page.

6. Click on the Play button at the lower right corner of the screen to
begin current game. Important: one must double-click a correct item
before it is selected.

7. The current game will automatically end when all of the correct items
have been selected.

8. To exit a game in progress, go to the File menu and select New
Game.

Program Content

• Grades One and Two: Classification: color, shape, design, class;
Grammar: naming words, action words, describing words; Phonics:
initial consonants, final consonants, vowels; Vocabulary: rhyming
words; Sentences: naming words, action words, describing words; and
Challenge: a random presentation of activity.

• Grades Three and Four: Grammar: nouns, action words, adjectives,
pronouns, adverbs; Phonics: vowels; Vocabulary: synonyms,
antonyms; Sentences: nouns, action verbs, adjectives, pronouns,
adverbs; and the Challenge activity.

• Grade Five: Identical to structure of levels Three and Four with the
exception of the following: Grammar and Sentences contain the
additional stimulus topics of prepositions and interjections.
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ZoomText Xtra (Win)

Publisher Retail Cost see notes section

Ai Squared
P.O. Box 669
Manchester Center, VT 05255
(802) 362-3612
http://www.aisquared.com

System Requirements
486 or higher processor; Windows 3.1 or 95, 16,256 or High Color display
driver; minimum 8 MB RAM (16 MB preferred), Windows sound card or SSIL
speech synthesizer (required for levels 2 and 3 only

Description
ZoomText Xtra comes in two levels now and a third is scheduled for release
sometime in 1998. Level 1 is a screen magnifier for the Windows 95
environment. Level 2 offers a fully integrated magnifier and screen reader –
designed specifically for the low-vision computer user. Level 3, which is still
under development, will add scanning, OCR, form-filling and printing.

Another innovative feature of ZoomText Xtra is its document reading
module, called DocReader. Existing in all three product levels, DocReader is
a full-screen environment for reading text from any Windows application.
DocReader automatically reads through complete documents, including web
pages and email.

This version also provides Microsoft's Active Accessibility which should be
installed if using Microsoft Office 97 applications.

Recommended Uses
ZoomText is intended for use by persons with low vision. It may also be of
value to individuals with learning disabilities.

Basic Use
1. To start ZoomText, choose the ZoomText icon from the Start menu.

2. When ZoomText is active, pressing Alt Delete turns it off. To turn
ZoomText back on, press Alt Insert.
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3. When ZoomText is active, pressing Alt Insert or Ctrl Shift U will
display the ZoomText User dialog box. Options may be selected from
menus or from Tool icons. Selections may be made from the keyboard or
with a mouse.

4. Choose Contents from the Help menu and browse through the excellent
descriptions of the programs functions.

Intermediate Use

Enlarging and Changing Text Size

Text may be enlarged in two ways: from the keyboard, Alt followed by the
Plus or Minus key will enlarge or reduce text size.

From the ZoomText menu bar: from the Options menu select Display then
click the Magnification tab if it is not already the front tab. From this dialog
box it is possible to set horizontal and vertical size, whether the text is
proportional (e.g. 3X (Horizontal) by 3X (Vertical) or not, and whether the
text is to have smoothed edges (possible with 256 display monitors).

Choosing Display Style

From the ZoomText menu bar: From the Window menu select the display
desired. The default view is Overlay. This view places an window in the
lower right quarter of the screen. Cursor and Pointer tracking are on.
Moving the mouse pans the screen display in this viewing window. The
remaining 75% of the screen remains at normal magnification.

There are five main display options: Full Screen, Lens (a movable, sizable
rectangle, H-split (horizontal split) and V-Split (vertical split).

Overlay

The default setting for ZoomText places the Overlay window in the lower
quadrant of the screen. Moving the mouse pans the screen; with tracking on,
activities using the cursor and mouse are focused in the window.

Re-sizing the Overlay View

It may be useful for students with learning disabilities to re-size the overlay
so that only one line of text is magnified. This environment can be used for
writing or reading. To do this:
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1. Bring up the User dialog box with Alt Insert or with Shift Control U.

2. Select the Re-size icon (the 1st from the left in the lower row of Tool icons.

3. Click the mouse pointer on one of the rectangular "handles" which now
appear on the outline of the current overlay window.

4. Click and drag the window borders to the desired positions (left border to
the left margin, lower border up a bit, top border down as far as possible,
right border a little to the left, if necessary. Click the right mouse button
to keep the desired size.

Full Screen

For persons comfortable with all of the screen magnified. Moving the mouse
(with tracking on) pans the magnified view.

H-Split

A magnified view of the screen is displayed in the lower half of the screen.
Moving the mouse pans the view in the window. Cursor track places cursor
activity in this view.

Saving Configurations

Configurations are easily saved or loaded into memory. Because a user can
easily save a personalized configuration, it is easy to make ZoomText work in
a highly customized setup.

To Save a Setup
1. Make necessary adjustments to ZoomText values.
2. Bring up the ZoomText User window with Alt Insert.
3. Open the File menu and select Save As.
4. Name the file (e.g., suzy). ZoomText automatically adds a .ztw extension.
5. The new configuration file is now listed at the bottom of the File menu,

and can be loaded from there.

Loading Configurations

There are several different ways to load a configuration: From the File
menu, select Load and select the file. Or from the File menu, select the
name of the configuration from the bottom of the file menu if it is there.
During a work session, once a configuration has been loaded, its name is
placed at the bottom of the File menu.
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How to Scroll Text

Having text scroll by in a magnified view can be an efficient way for some
persons to read text. Entering the hot key command Ctrl Shift S brings up the
Scroll icon. Click and hold down the mouse button and the screen starts
scrolling action in the direction of the mouse drag. Click the right mouse button
or press Escape to leave the scroll mode.

DocReader

1. Click the DocReader button, the open book icon without the pointer, to
launch DocReader to read text from the last active application. The
DocReader module is a reading environment that reformats, magnifies and
speaks text (level 2 & 3 only) from any Windows application.

2. The text of the last opened application is reformatted into the DocReader
window and a toolbar appears at the top. This toolbar is used to read
through the text in a method similar to using a tape recorder's buttons. Click
on the first button to start reading through the enlarged text. Click it again
to stop. For more detailed descriptions of the buttons, see the descriptions
from the Help menu..

3. With Level 2, speech output is also possible and can be controlled either from
the DocReader window or the icons on the application. The icons control the
various aspects of the speech function. To learn each icon's function, from
the ZoomText Xtra application, click on the ? icon, then on the icon you wish
to learn about. A short description will pop up which explains the function of
that icon.

Notes:

Level 1 Pricing
ZX Level 1 (for Windows 95 and 3.1) $395
ZX Level 1 Plus (includes ZoomText for DOS) $595
ZX Level 1 Upgrade * (from older ZoomText versions) $95

Level 2 Pricing
ZX Level 2 (for Windows 95 and 3.1) $595
ZX Level 2 Plus (includes ZoomText for DOS) $795
ZX Level 2 Upgrade * (from ZX Level 1) $200
(from older ZoomText versions) $195

Site License Pricing
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Many site license options are available. For details, see the web site listed
above.
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Personal Trainer ACT (Win )

Publisher: Retail Cost: $ 49.95
Davidson & Associates, Inc.
P.O. Box 2961
Torrance, CA 90509
(800) 545-7677
http://www.davd.com/

System Requirements:
Multimedia PC with 5 MB free space; Windows 3.1 or 95; 8 MB RAM

Description:
This program contains the equivalent number of sample questions equal to
five full ACT tests. The subject matter range:
• English: usage and mechanics, and rhetorical skills;
• Reading: arts/literature, social studies/science;
• Mathematics: pre-algebra, intermediate algebra/coordinate geometry,

plane geometry/trigonometry;
• Science reasoning.

Recommended Uses:
The program provides practice in subject matter areas and may be used for
general review as well as for practice in test preparation. The program
actually is designed to provide a structure (including a pretest) for preparing
for the SAT. Designed for the good to average reader, this program also
provides tips and strategies for test taking in these different types of subject
matter.

Basic Use:
1. Double-click on the icon to start the program.
2. Click on the advertisement screen to get to the main screen.
3. Click on the Visitor button, a choice which allows the user to explore the

activities of the program.
4. Click on the English 1 button to enter subject matter activities.
5. Continue with that subject, if desired.
6. To change to another subject area, click on the Subject option of the

program menu bar and select another area to explore.

Notes:
This program is one of many test prep programs developed by Davidson
software.
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